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Results Race Registration Package
Instruction package to help make your race easier
Entry Forms
Distribute your entry form at least two months ahead of your event. Use Data Blocks on the form to ensure
clear readable data. The format we recommend is attached. We can help design your flyer for an additional fee.

Bib Numbers (Pull Tab Races)
Order Bib #s for anticipated numbers of entries. (ie. 1-500 Runners, 501700 Walkers). We recommend Bibs from Marathon Printing, 1-(800)2554120, or “http://www.marathononline.com/” . These are the finest quality
of all the companies out there and the best prices. We recommend Custom
Type T bibs, with Type H Standard Pull Tabs. A custom logo reduced by
60% intensity and bright colors adds to the image of your race. We recommend that you order your bibs with Imprinted Bar Codes to help speed
scoring. You may want to order Walkers bibs with Yellow Floodcoating to
help identify them for scoring. Order four Safety Pins per Bib #.

XTH ANNUAL 5/10K RUN/WALK
Last Name

First Name

Team or Affiliatio n

Age
M

F

Bib Numbers (Bib Tag Races)
Order Bib #s for anticipated numbers of entries. (ie. 1-500 Runners, 501-700 Walkers). We recommend Bibs
from Marathon Printing, 1-(800)255-4120, or “http://www.marathononline.com/” . These are the finest quality
of all the companies out there and the best prices. We recommend Custom Type N bibs. Request standard size
“ChronoTrack Temaplate” bibs with an area at the lower left of the bib for labels. A custom logo reduced by
60% intensity and bright colors adds to the image of your race. You may want to order Walkers bibs with
Yellow Floodcoating to help identify them for scoring. Order four Safety Pins per Bib #.
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Data Entry
We will help set you up with software and formats for your data entry. We need specific data to be able to Score
your Race. Critical fields we need are: Bib #, Race, First Name, Last Name, Sex, Age, and Team Name. Enter
in the Race field the Value of "R" for Run, "C" for Wheelchair, "W" for Walk. Enter shirt sizes "S" - Small,
"M" - Med, "L" - Large, "XL" - Xtra Large, or "2X" - XXL if ordered. If you have teams, come up with unique
names for each team for scoring. Use our software to print Labels for your Bib Strips with: Bib #, First Name,
Last Name, Sex, Age, and Shirt Size. Use Avery 5160 label sheets (3X10) when printing from our software..
Shaw, Robert
Sex M Age 44 Size XL
Bib # 125 Race 5KRUN

Mail-In Registration
Type in all your data and assign a Bib Number. Provide us a copy of
your early data by E-mail to "kei@eventtiming.com" for verification.
When you finish data entry, bring the Thumb Drive that we provided to
us for Race Day. Print Bib Labels for all participants and affix to the
lower left portion of the Bib Pull Strip for Pull Tab races, or to the front
or back of the Bib Number for Bib Tag races.. Print as many Alphabetic
lists as you need for registration. You can also print Race Reports and TShirt reports to assist you.

XTH ANNUAL 5/10K RUN/WALK
L ast N ame

F irst N ame

Team or Affiliatio n

Shaw,
Robert
Shaw,
RobertT-Shirt Size

A ge

XL

Age 44
Size XL
MSex
35 MBIB#
125
FResults
Timing 5KRUN
BibM #“http://www.runres
125Event
Race
ults.net”

Last Name

First Name

BIB# 125

Shaw,
Robert
Shaw,
Robert

Team or Affiliation

Age

T-Sh irt Size XL

Age 44 Size
M Sex
35M M
BIB#
125 XL
Bib
#F 125
5KRUN
ResultsRace
Event Timing
“http://www.runresults. net”

If you order Generic or Free Bib Numbers from people like Running
Times, we will print you Barcode labels for $0.04 per label to place
above the Bib Number on the tear-off Bib Strip for Pull Tab races.

Last Name

No.

125

First Name

Shaw

Robert

Team or Affiliation

Age

35

X
M

F

Late Registration/Package Pickup
Have each individual check his/her information on the Label for accuracy. Pass all changes or errors to us.
When runners sign up at the registration, make sure the Bib Number you give is marked clearly on the entry
form for data entry. Fill in data for "Name", "Sex", and "Age" on the Bib Numbers or Bib strips by hand as
seen above.
Tell entrants to pin their Bib on the front of their shirt for scoring, DO NOT FOLD THE BIB.
125

Use a correction sheet for errors found at package pickup, making changes in the blocks or Comments.
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Raceday
Bring us the Thumb Drive that we provided you and any late entry forms not input in the computer. Bring us
late registration entry forms from raceday registration as soon as you can by runner so we can enter them.
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Results Data Entry Procedures (RunScore)
Insert the Thumb Drive that we provided you in the computer, windows should open an AutoPlay window that
allows you to select "Open folder to view files" from the "General Options” section. If this is the first time you are using
this computer with the Thumb Drive, Double Click on “First_Time_Run_On_Computer.bat”, answer yes, yes, and Ok
to the next three prompts. When that is complete, or if you have used this computer before, then Double Click on
“Start_data_entry.bat”. The Thumb Drive also contains this file and a Readme that gives you simple instructions to use
the drive. The first time you run this from a machine, you will get a message that you are using a unregistered verstion of
the software, just continue and it will open the RunScore window.

Select “Tools>Register Runscore” and type in “Data
Entry” with no password and click on Register to set your
program up for Data Entry. If you don’t do this, the
program will stil run, but you will keep getting the UnRegistered message.
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Select “Tools>Preferences” and match the values with those to the left. These will make things much
easier and cleaner for the data entry. You don’t have to do this on all machines that you work on, but it
will make it easier on the primary machine that you use. You can take this Thumb Drive from machine to
machine, without having to install any software and all the data remains on the Thumb Drive. If you want
to use several machines on a network to type in the data all at once, contact Kei at 850-803-8740 and he
will tell you how to set up the network functions of the software and install RSClient on all your other
machines.

To start, open the “Listings” screen by clicking on the “Listings” button, resize it to the right, and open the
“Enter/Edit Names” screen by clicking on the “Enter” button. This sets up your workspace for data entry for
your race. RunScore has a set of Menu items across the top and a set of Icons that have drop down titles when
you place the mouse over them. There is also a set of Button Bars that allow you to access all the screens in
RunScore.
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The “Listings” screen contains a list of
tools, reports, and output files that will
make your and our lives much easier.
The “Enter” screen allows you to enter
your registrations.

To start entering your race entrants,
click on the “Enter” screen, and create
a new record by hitting the “F9” key.
A blank record should appear, like the
screen to the right. If any data is
present on the screen and you type
over it, you will be destroying previous
data. First, type in the first Bib number of your sequence, then type in the
race value (run, walk, 5K run, wheelchair, etc..) and RunScore will advance
to the “Last Name” field, type in the,
“Last Name”.

After you type in the first two letters, Type Ahead
will try to match it to data already in the database. If
this is the correct name in the field, you can just hit
enter to accept it, or select the correct one from the
drop down list, or continue typing. If you type in the
name and it is still trying to Auto Fill a name, then
type a space and it should accept what you have
typed. Type Ahead will work in the fields for
Names, Address, Email, Team Name, and Team Div
to make things easier to type in data from multiple
people with that same data.
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When you type in all the info, there is no need to type in
capitalization, the program does it for you. When you type
in the Birthdate and the Zip, once you save the record with
“F4”, it will fill in “AGE1” and the “City” and “State” for
you. “F4” will save the data, but leave you in the record to
see the changes. If you want to Save and continue to a new
record, with the next bib number in sequence, you need to
hit “12”. RunScore will open a new record with the next
bib number and allow you to accept the bib and hit enter or
change it to continue to add new records. Periodically you
need to Save/Advance with “F11” to save a backup of your
data.

Periodically run the listing file “Save_A_Backup” to save a
remote copy of the database and all your entrants. If you
ever have to recover this data, contact Kei at 850-803-8740
or kei@eventtiming.com for instructions to recover your
previous data.

You can search your database by typing into any
field and hit “F3” to search for everything left of the
cursor. If the string is not found, you can answer
“yes” to do another search, “no” to exit to a blank
new record, or “cancel” to stop searching and return
back to what you just typed in to search for.
You can also review your data from a
“Browse” mode, by clicking on the
“Browse” button. You can use the
window on the bottom of the screen,
by selecting the field to search from.
You can also page up and down, and
scroll through the data. You can also
edit data from the Browse screen, by
clicking on the record, to highligh the
line, place the mouse over the field to
change and Right Mouse Button click
to select “Edit Field”. You can change
the data and then hit the up or down
arrow to save the change and continue
in another record. Just click anywhere
else on the screen to exit the Edit
mode.
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From the Listings screen, you can run Tools to Check for possible Sex errors by first
names, check for Blanks in records, check for duplicate records, print missing bib
numbers, Save a Backup, or update the values for a field in all records.
You can also use the Upload/Export section to email data to Runners World for their
bib numbers, email a copy of the data to the scorer, email confirmations to entrants, or
export the database to a file. You can also Email data to “Kei” for him to check it.
You can run a myriad of reports to show Finances for your race, shirt totals, team
numbers, lists for your announcers, Bib labels and entry lists for registration, and
reports for race totals and the such.
These reports can be run to the screen, by clicking on or selecting “Preview”, F5, or
the Right Mouse Button (RMB) menu. You can also send them to the printer, HTML,
or the internal editor. There are Icons for each of these operations and from the RMB
menu.
When you run several listings, like “Bib Labels”, you will be presented
with an “Input Dialog” window to make selections to refine your data. The
window on the right comes up for Bib labels, to select the sort by “bib” for
numerical order or “lastname” for alphabetical order. After that, you will
be asked for the first and last bib number to include in the printout or
report.

If you selected “bib” and bib
numbers “1” to “30” and sent the
listing to “Preview”, you would get
something like the image to the
left. From here you can review all
the pages, zoom in, or even print
from that page. This is a full
screen display, so you must “Cancel” or exit this screen to return to
the norma RunScore screens.

If you send to the editor, the listing file
“Entry_List” and sort by “lastname”, you would
get something like the image to the right. You
can then modify this file in the editor or save it to
another location.
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If you print out a report of the “Shirt_Totals”,
you will receive information like that to the left
to see all the numbers and precentages of people
who requested shirt sizes. Anyone without a
shirt size is ignored.

Online Signup Data Import Procedures
You can download the data directly from your ActiveWorks, ChronoTrack Live, EventBright, RaceIT, or RunSignUp
accounts into your race. With RunScore, this is a very simple process and works directly with these online services to make
it almost automatic for data download and on some, even has a Sync process to make sure that changes made in either
location are carried over to the other..
First thing that you need to do, is go into “Tools/online system” and select your Online System. Next, go to “Online/
Signin” and enter your user ID and password for the appropriate [online system]. You will then go into “Online /Select
Event(or Race on RunSignUp)” and select your event/race to download data from. Next, you will need to select ”Online>
Download registrations”. You will be queried on what type of download you want to accomplish.

The download allows you to do a “Full download” of all records,
or an “Incremental download” to get only the new entrants from your
last download. The new data is now in the database without bib
numbers.

Next, you will need to assign the next numbers in sequence to these new records that you just downloaded to use them
in your listings. You can run the “Assign_Bibs_New” listing to assign numbers to these open records. Find your next bib
number, double click on the “Assign_Bibs_New” to run it. Set the first bib number and the highest bib number with something
like “6,000” or just leave blank and hit “OK”. You are now set to continue with data entry from your mail ins.
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Other Online Data Services Import Procedures
Download the data from your service in a “Comma Delimited” (CSV) file.
Select “File>Import Data” and select the file you downloaded from the
online service. This screen pops up if the fields don’t match and allows you
to map all the data needed in RunScore. Notice that the CSV has a field
named “Gender”, select “Sex” from the RunScore fields and hit “OK”.
Continue this for all fields you want to use in RunScore, or “Ignore” the ones
that are not on the “Enter/Edit Names” Screen. The new data is now in the
database without bib numbers. Just assign the next numbers in sequence to
these new records and you are done. You can run the “Assign_Bibs_New”
listing to assign numbers to these open records. Find your next bib number,
click on the “Assign_Bibs_New”, click on “Ctrl-X” to ungrey the listing and
run it. Set the first bib number and the highest bib number with something
like “6,000”. Select “Assign_Bibs_New”, click on “Ctrl-X” to grey out the
listing again. Run the file in listings, “X_update_entries” to update all the
special information. You are now set to continue with data entry from your
mail ins.

Required Data on CSV file downloads
The critical Data that you need to download from your online service like imAthlete, SignMeUp, or others is listed below.
This data must be in a “Comma Delimited” (CSV) file. Here are the minimum fields needed to score your race:
Bib Number (if available), Race type, First Name, Last Name, Sex, Age, Birthdate (if available), Zip Code, and Race
Category (if available).
You can add Addresses, Entry Fee, emails, and other fields that you may want to use all the listings on the Thumb Drive.
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Race Director Checklist
Six Months Out or As Soon As Possible:
1. Confirm the Date, Time, and Cost structure for your event. We recommend a price structure that increases from the
original amount $2-5 about 2 weeks out to help you get early entries to help with your planning and a $5 jump on Raceday to
hold down the lines and confusion on Raceday with this registration and last minute package pickup.
2. Start work on your flyer and post your event with the local papers and the online calendars. This is an excellent
time to set up Online Registration to help promote your event and make signups easier. Make sure that you use the
address for the Online Entry on all your flyers and advertisements. We can help you accomplish this and the Online
Entries will increase you final numbers and make registration much easier.
3. Start arranging for your Bib Numbers. We recommend that you use Bibs from Marathon Printing, 1-(800)2554120, or “http://www.marathononline.com/” . These are the finest quality of all the companies out there and the best
prices. We recommend Custom Type T bibs, with Type H Standard Pull Tabs for Pull Tab races. For Bib Tag Races, we
recommend Type N bibs in the standard size “ChronoTrack Template” without pull tabs. A custom logo and bright colors
adds to the image of your race. We recommend that you order your bibs with Imprinted Bar Codes for Pull Tab races to
help speed scoring. You may want to order Walkers bibs with Yellow Floodcoating to help identify them for scoring.
Order four Safety Pins per Bib #.
4. Get permission for use of facilities and roads as soon as possible from school, city, county, or park board. Fill out
your letters to get approval from the community organizations and local law enforcement. Arrange for Police and Medical
support for you event. You may have to pay fees for your activity.
5. Arrange for Insurance for you event.
6. Start working your Awards and T-shirts for your race.

Three Months Out:
1. Publish your flyer and have it available for handout at all local races. Drop off a few to all the Sports and Running Shoe
stores in the area. You also want to drop them off at some of the Gyms and Fitness centers, especially the local military bases.
It is very helpful to provide them to the local Running Clubs to mail out in their Newsletters.
One Month Out:
1. Make up a large map of course for display at starting area. (If previously used course, scheduling chairman will have a
copy). Map should show start, finish, turning points, aid stations, major landmarks and distances. Also make page-size maps,
possibly using one side for race instructions and the other side for the map.
2. Organize Staff and Volunteers and equipment several weeks before the race. Do not expect to draft any volunteers
from the onlookers a few minutes before race time. Get your staff ready as early as possible. You will need: Registration
Chairman; Registration Volunteers; Aid station workers for your water stops every 1-1.5 miles; Finish line Volunteers;
Road Guards for major intersections or turns (can be Police Officers you arranged for); Finish area refreshments Volunteers; and an Awards coordinator. Coordinate again with Police and Medical personnel to make sure they will be there.
3. Equipment: Make sure you arrange for the following items: P.A. System or megaphone; Entry forms and extra
race numbers (for race day registration and preregistration errors) Pens, pencils, and Safety pins; Tables for registration
and the water stops; Adequate money for change and money box; Water, cups and trash containers for the water stops
and finishline aid station; Race instructions/course map sheets; Awards (age group and finishers); Bathrooms; Refreshments (Water cool, not cold, and possible PowerAide type drink); Bulletin Board or similar provisions for posting results.
Registration/Package Pickup Day:
1. Ensure that early entrants are in the computer and that labels have been applied to the Pull Tab on the Bib Strip.
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2. Print out Alphabetical listings to post or have available at the Registration table. Separate Package Pickup from
Late Registration. Have one table for blank entries and pens for late people to fill out forms and pay for the race. One
table should have a cash person to accept this money and send the person on to someone who will issue a Bib Number
and fill out the Name, Sex, and Age on the Pull Tab of the Bib Strip and place the Bib Number on the entry form for later
computer entry. The late entrant can then pick up his T-shirt and finish the entry process. The third table will have the
early signups Bib Numbers separated by Last name or Number for package pickup and then receive their T-Shirt also. It
is best to separate the T-Shirts by Pre-Registered sizes/ numbers and the remaining sizes in a second location for the late
signups. This way the early people get the sizes they ordered.
3. Collect the entry forms and any corrections sheets to provide to the Data people.
Raceday:
1. Finish marking a road course at least two hours before the first race (can also be done on day before in most
cases). All corners should have either arrows made of Chalk or flour on the road or a sentry. Fun runs should have sentries rather than arrows at sharp turns, especially at a turnaround point, as participants are often inexperienced runners.
All mile markings should be marked similarly and prominently beside the course.
2. Be at race site at least two hours before the first event.
3. Inspect facilities - toilets open, gates unlocked, etc.
4. Set up registration and number and shirt pickup. Be sure to provide plenty of help so registration will not cause a
delay in the start. Display the course map prominently. Have membership information available if a member of that
committee will not be present.
5. Insure all your volunteers are available at least 30 minutes before the event, including; aid station personnel;
course sentries; finishline volunteers; Finish area refreshments Volunteers; and Awards presenters are identified.
6. Touch base with police and medical personnel. Ensure the medical personnel are near the finishline.
7. Announce 30, 15, and 10 minute warnings before each race and any other pertinent information.
8, Remind runners to plainly display their race numbers during the entire race with the number pinned to the front
of their shirt or shorts in an unaltered, unobstructed and readable state (cutting or folding numbers is not permitted).
9. Call runners to starting line and announce briefly: two-command start procedure, finish line location if different
from start, where split times will be read, aid station location, and any special weather or traffic (course) warnings.
10. Preliminary Results will be posted periodically during the race, have all athletes check their information (i.e.
Name, Sex, Age, and Race Run/Walk) to ensure that their data is correct. It is easier to make these changes now, not
during the Awards ceremony.
11. Award prizes as soon as feasible after each race, if they are having fun with the Band and refreshments, delay
slightly.
12. Ensure that the local newspapers are contacted with results. We contact all newspapers you identify by Email
and place the results on our web site “www.eventtiming.com” immediately after the race.
Post Race:
1. If you have any challenges, missing times or complaints, contact Kei at (850)803-8740 or email him at
“kei@eventtiming.com” as soon as possible and we will work them out.
2. When people call, remember to have them look for the most recent results on the Results Event Timing WEB site:
“http://www.eventtiming.com”. Please forward any Email questions or problems to: “kei@eventtiming.com”.
3. If you received race promotion materials from “Running Times” or “Runners World” magazines, they expect you
to send them a full list of addresses for your entrants. We will send that file for you upon request.
4. We will provide you with a full set of the data for entrants after the race, that includes the full data for early
entrants and just the critical data for the raceday entries. This will be in a CSV format that can be opened in Excel or any
other spread sheet/database program for your future records and you can use the entry forms to flesh out the raceday
entries. This will give you access to the addresses and emails for all your entrants.
4. Keep good notes on your race to help remind you for next year, or help the person that takes over for you.

11

Package Pickup
R
Shaw,
Shaw,Robert
Robert T-Shirt Size XL
Age 44 Size
MSex
35 M BIB#
125 XL
Bib # 125
Race
5KRUN
Results
Event Timing
“http://www.runresults.net”

Have each individual check his/her information on the Bib strip for accuracy. If there are errors, annotate the
changes on the “Correction” form with the old “Bib Number”, new Bib Number if applicable for replacement
bibs. You can then identify the correct or new “Race”, "Name", "Sex", and "Age" on this form. You also have
room in the “Comment” area to put your changes in plain english. Pass these forms on to the scorers as they
fill.
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Late Registrations
Check the entry form for complete information, especially Name, Sex, Age, and Race. Make sure the Bib
Number you give the entrant is marked clearly on the entry form for data entry.

125

Last Name

First Name

Shaw

Robert

Team or Affiliation

Age

35

X
M

Robert Shaw M 55

F

Fill in "Name", "Sex", and "Age" on these Bib strips or the back of the bib numbers without pull tabs, by hand as seen
above. Tell all entrants to pin their Bib on the front of their shirt for scoring. DO NOT PIN THE PULL TAB! DO
NOT FOLD THE BIB!
Registration Forms
Try to stack the entry forms face down as you finish with them. Bring these late registration entry forms from
raceday registration to the race scorers as soon as you can by runner so they can be entered before the race.
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RACE TEAM ROSTER

PAGE

OF

Each member listed below, must be signed up for the race by the team cutoff date and then these names will be
added to the list of Team members for your team. No additions after the cutoff date. This is not a signup form.
TEAM NAME
TEAM TYPE

FAMILY

CORP

SCHOOL

MIL

OPEN

FEMALE

MALE

COED

(Choose Appropriate type)

TEAM MEMBERS
LAST NAME

FIRST NAME

1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
Tea m
Contact:

Ph on e
Number:

SEX

AGE

